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www.shebiz.nz

Company Setup

PayBiz main menu > File > Company > Company Details

https://www.shebiz.nz/pbhelp/docs/PB_CompanyDetails.pdf

Company Details

Identity Registration \/ Dates || other || Form |/ | Constants || Printers || Financial || ATO Portal || Paybiz
Company Name  payBiz AUS DEMO
Browse Other
Co. ABN No. 67094544519 Bar Cade ID ¢ Logos
Company Logo Clear
Company URL
Remit To Address p.o, Box 72
CROMWELL ACT 1234
@ put Company Details on Invoice
@ Put Remit To Address on Invoice Colour Bold
Debtor Direct  Direct Credit to: 03-0214-0562478-03 Set i
Credit Message
Invoice Message Thanks for your business...long may it last! Set @«
@ Use in email body
Romalpa Text
Set —
Print Save Exit

o Enter the Company Details under all header tabs - Identity, Dates, Constants, and so on.
e Save
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Company Payroll Settings

PayBiz main menu > File > Company > Company Details > Paybiz tab

Identity Registration \/ Dates || other || Form |/ \f | Constants || Printers || Financial || ATO Portal Paybiz .
-
Allowance
%
_ Pay Type Default Pay Period Weekly v
Annual Holiday 0.00 Adjust all staff
. Default Paid Up To 0 Update all Staff
Stat Holiday  0.00 Adjust all staff
i Default Pay Leave as % of Gross on Employee Deduction pay type for OD Wages QD
@D Default Add T/S lines to Payslip set on Employee Tally Sheet Hours/Day 7.30
@D Default No Auto Payslip ticked on Employee Running Costs %  0.00

@D include all Staff lines on the Wage Costs report
i Payslip per Tally Sheet Date

i Include Super in Full Rate % 0.00

Default JobfTally Sheet Standing Charge

‘/alua|Basis |Show |Charg 2|+ Supdl+Mo

ADRIMN Adrministration Fee 0.40/$/ea M I I &l &l &l &l

FT Payroll Tex 5.00/%% M M iF i M M M

SUF Superannuation 10.50/% M M A M M M Y

W Work Cover 14.00/%% M iF M M M i M
Add

Print Save Exit

e Configure the payroll defaults
e Create the default standing charges for Cost Plus jobs
e Save

User Setup
PayBiz main menu > File > Users > Add

https://www.shebiz.nz/pbhelp/docs/PB_UserFile.pdf

e Enter a unique userid, priority, and other relevant details as required.
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PaySlip Setup

PayBiz main menu > Payroll > Payslip Setup

https://www.shebiz.nz/pbhelp/docs/PB_PayslipSetup. pdf

Leave
Settings

Payslip Setup
- Payslip shows AL left o Payslip shows Time Detail @
Show leave in days not hours i Payslip shows Pay Rate @D
Show Entitlement not Accrued o MNo Tfn No an payslip
Payslip shows S/L left .o Employee Type on payslip @O
Show leave in days not hours Leave accrues at fixed amount per week o

Show Entitlement not Accrued o Payslip shows Date Paid @D
yslip shows Days Long Service Leave left Lo Fold and seal type of payslip .
Show leave in days not hours i Small fold and seal payslip
Show Entitlement not Accrued i Use NZ Payday Filing (i@

show Ytd Gross and Payg @

Email From  info@shebiz.nz

Payslip Comment

Save

Use AU STP Filing @D

Mo Email Copy (i

Exit

A4 Payslip (with T/S details) @D Inc Header Size for Posting @D

Print avg hourly rate on payslip

Print payslip lines in T/S date order @D

Print Company Logo on payslip @D

Show Full Rate .o

Show Company ABN No @

General
Settings

Single Touch
Payroll

Payslip Type &
Format Settings

Set all the requirements you want to define your payslips
Save
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Bank Setup

PayBiz main menu > Banking > Bank Accounts > Add

https://www.shebiz.nz/pbhelp/docs/PB_BankAccounts.pdf

Bank Account : Enquire/Change

ldentity Local Currency Other Currency Documents
Account MO | 03-0214-0562478-00 Closed &
Cumrent Balances Forward Balances
Afc Name DEMO Bank AUS Bank 16,681.20 Bank -16.364.96
Bank G/L Cashbook 15,629.30 Cashbook 29,30
COther Currency Use On Stmt. & Unpresented -1.052.00 Forward Date 3/02/202°
Bank Code 1234567890 Exc. From Cashflow i Last Rec.  31/12/2017
ExportType AMZ Australia (.C5V) -
Default account for payments and receipts @D
Save =4 _ - _ Details Analysis Delete Exit [ 14 1% (% cashFlow

e Enter Account No

e Enter A/c Name

Enter Bank Code

Select Export Type if you use bank software to transfer pay files
Save
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Debtor Setup
Debtor Groups
Useful for grouping your clients into categories for reporting and costing purposes.

PayBiz main menu > Debtors > Debtor Groups > Add

https://www.shebiz.nz/pbhelp/docs/PB_DebtorGroups.pdf

Debtor Group : File Access (Mo in List: 2)

Group |Description
MER  MERINO FARMER
XBRED XBRED FARMER

Debtor Group : ADD

Group
Description
Group MER
All Debtor Group's by Group ~
All Debtor Group's
Pi Add Display Exit [0 (>3 Search Restare Report

e Enter a Group code and Description - for example, CB - Crossbred
e Save & Add to add more, Save and Exit to close page
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Debtors
PayBiz main menu > Debtors > Debtors > Add

https://www.shebiz.nz/pbhelp/docs/PB_Debtors.pdf

Debtor : Enquire/Change

Alpha Key BROWF Acct No 1309 Active @D | Billing Details || Financial Summary | Direct Debit |
Mame F ] _
armer Srown Outstanding 3228.06 Receipt
Contact Mame: First  Jaymes Last Brown
Mail Merge Title Jaymes Pay By Direct Credit -
Address warroon Dr Mo Interest i
Brownton 1234 VIC
Interest Rate 0.00
Due days 0
Phone No | 04412341234 Credit Status 0 k. v
Fax Mo
Mobile Mo
0224404440 Invoice Method Email v
ABM Mo 123123123 Exempt G5T \_k»
Statement Method Email w
Email lisa@shebiz.nz, brown@shebiz.nz i
Receipt Methad Mo Receipt v
Variance Value 000 % WUsed o
General \f Standing Charges Shed Contacts Documents Xero
Debtor Groups Comments
1 MER MERIMO FARMER
2
3
4
Debtor has Custom Rates
Exclude from Planner i
Save ia};iit ::Cidd Details Analysis Delete Exit JOAZ L Options
e Create an alpha code unique to this Debtor
e Enter all Debtor personal details
e Enable and add Standing Charges for Debtors charged on a Cost Plus basis
e Save & Add to add another Debtor, Save & Exit to close the page
e Add Custom Rates via the Details button

Note:
The areas highlighted indicate the minimum detail preferred
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Pay Type Setup
Pay Types

PayBiz main menu > Payroll > Pay Types > Add

https://www.shebiz.nz/pbhelp/paytypes.html

PH MonTaxable Allowance Press Hire

pL Taxable Allowance PARENTAL LEAVE SlLMEED Fay Type
PR Time Presser
PRIME Super Fund Deduct Superannuation Pay Type Additional Tax oK
PRINM Super Fund Deduct Additional Superannuation ® pay Type Allowance
PRISSS Super Fund Deduct Salary Sacrifice $
RAM Taxable Allowance Shear Rams ) Pay Type Child Support Cancel
REPAY Taxable Deduction Repayment of Loan -,

pay - Pay Type Debtor
RESSUP Super Fund Deduct Rest Superannuation
RUM Taxable Allowance Shedhand Run ) Pay Type Deduction
SAL Salary SALARY .

: Pay Type Leave
SHH Time SHEDHAMD HOURS
SL 5/Loan STUDEMT LOAN 1) Pay Type Alt. Day
SS MNonTaxable Deduction Salary Sacrifice for Car Loan .
STAT Taxable Allowance STATUTORY HOLIDAY PAY Pay Type Lump Sum
SUPD Super Fund Deduct Superannuation Dollar ) Pay Type Salary
SUPEC Super Fund Deduct Super Sal Sacrifice
SUPSS Super Fund Deduct Super Sal Sacrifice Ry LEE i
TEST Taxable Allowance TEST ) Pay Type Alt.Day Payment
) Pay Type HE.CS.
Pay Type TEST v oP
ACTIVE Pay Types by Type - Pay Type Superannuation
All Pay Types ) Pay Type Time
Pick add Display Exit [ 1€ 1% (¥ @ search ESToTE REPOTT

o Select a pay type from the above list (the following example uses Pay Type Allowance)
Note:

Refer to PayBiz Pay Types for full documentation on each above Pay Type
e Click OK
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Pay Type allowance : Enquire/Change

Pay Type RUN

Non Tax Type

Print Consalidated i
Wark Cover Applies @

Variance Applies @
Include in Unit Tally & (per Head / Each)

Invoice Text  Shedhand Run
Inv G/L code
Invoice Order 30

Charge Rate 61.0000

Comment

Create an alpha code unique to each Pay Type and enter a Description,
for example, RUN - Shedhand Run

Enter all other details as above if applicable

Save & Add to add another Paye Type Time, Save & Exit to close the page

Pay Type Allowance : Enquire/Change

Pay Type Fs
Description  Flock Shear Inactive ' Rate
Base Rate 5.0400 Full Rate 5.0400 Caloulator
G/L code
Allowance Type Other ~
Report As Gross @D Taxable wot @ Don't report to ATO

Mon Tax Type

Print Consolidated i
Work Cover Applies @D

Variance Applies @
Include in Unit Tally @C  (per Head / Each)

Invoice Text  Flock Shear

Inv G/L code
Charge Rate 6.2000 Invoice Order 0
Comment
Save =2 e Details Analysis Delete Exit [£ 14

Description  Shedhand Run Inactive \_uw Rate
Calculat
Base Rate 61.0000 Full Rate 651.0000 Lalcutator
G/L code
Allowance Type Other ~
Report As Gross @0 Taxable war @ Don't report to ATO i

W
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Super Fund Setup
PayBiz main menu > Payroll > Super Fund Setup

https://www.shebiz.nz/pbhelp/docs/PB_SuperannuationAUS. pdf

Superannuation Fund : Enquire/Change

Fund Name  prime Super

Fund USl 5056233582300

Create Mew

Fund ABM 30 562 335 823 Pay Type

Employer ID 123456

Bank Account Detaills  34123400-123546

Electronic Service Address

Configure the Super Funds with the relevant details, provided by the fund, for the funds your employees use.
Create a Pay Type Superannuation for each fund, selecting the relevant Super Fund and Contribution Type.

Employer Use Woti + Overtime - do NOT set for Superannuation Guarantee (SG) pay types.
This allows the Overtime setting on Time pay types to be used for paid leave that does not attract SG.

PayBiz main menu > Payroll > Pay Types > Add > Pay Type Superannuation

Pay Type Superannuation : Enquire/Change

Pay Type PRIME

Description  Prime Superannuation Inactive i

Employee Contribution is Dollar & _Emplovee Contribution js Pretax oo

Employer Contribution is Dollar i Employer Contribution % 10.00

G/L codes
P&L expense 514000 Super Deductions
Super Fund B/S 98.0000  Super Employer Contirutions

Employer Tax 98.0000  Super Employer Contirutions

Fund Details

i i No Threshold @O
Employer Use Woti + Overtime i Reportable Super % 0.00

Salary Sacrifice To Other &

Fund US| §0562335823001 Contribution Type  standard ~
Fund ABN 50 562 335 823 Prime Super Fund
Save Save S Details Analysis Delete Exit AS 22
- & Exit & Add * & = - ‘ ‘

Add the appropriate Super Pay Type to the Standing Lines for every employee.
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Employee Setup

Employee Types
PayBiz main menu > Payroll > Employee Types

Employee Type : File Access

Mumber Description

1 Shearer
2 Shedhand/Presser
3 Cook
4 G5
5 Office
Insert Row Exit

¢ Insert Rows to add lines
e Enter an Employee Type, the number will increment automatically
e Exit to close the page
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Employee

PayBiz main menu > Payroll > Employee > Add

https://www.shebiz.nz/pbhelp/docs/PB_Employees.pdf

Employee : Enquire/Change

Code kgﬁ surname  Smart Protected _iw A/L Allowed Alt. Days 000 days
First Names  pdaowell 5/L Allowed Max 5/L o hrs
TFN Number 123123125 Period  Weekly v Ent+Accrued Entitlement
Commenced  1/02/2018 Finished AL (hrs)
Tax Code Wt Withholding Rate 2500 % SR
Residency Resident - Last Payslip
Staff Acct. Gender pale v Bty 5/04/2020
Mett 1124.7
D.O.B. 14/08/1992 Age o Years Srv.
Type Shearer - Team
Cantact Rates 1'..'f Einancial \f Leave Standing \f Comment Documents. ."..'r STP \f Training
e ?}%ne}f MNSW 1023 Notes
Home Phane Mobile
Email Wark Email Payslip rk a
Email Home  max@shebiz.nz @ Email Payslip to home address
MNext of Kin
Phone Relationship  Other -
Saye ;‘ I:-n Details Analysis Delete Exit |% \': \‘ \‘
o Create an alpha code unique to each Employee
e Enter all personal details
e Click each tab in the sub header bar as shown below and complete all details as required
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Y f . . .
Contact Rates \y Financial Leave Standing Comment Docume
Ratel 30.00 Salary 0.00
Rate
Calculator Rate2 0.00 Aust.FBT 2100
Rate3 0.00 Acc. Date
Averages
Rated 0.00 Mo Auto Payslip @0
Hours/Week a0 Full Time Student Exemption
. Add T/5 lines to Payslip @D
Basis ¢ = Casual E
Contractor e
Branch
Base Rate Variance 0.0000  Use % value instead of %
Contact Rates Einancial Leave Standing Comment Documents STP
Bank Account Amount Reference YTD Analysis G/L Expenszes
061234-0123456 0.00 DEMO Wages Payg 0.00  Wages
0.00 HECS 0.00 Payg
0.00 E/Prem. 0.00 G/L Liabilities
UnPaid
0.00 Gross 0.00
0.00
Cash Amount 0.00
Superannuation Member No  PRI1234567
Contact Rates Financial Leave Standing ."..'; Comment Documents STP Training
s [ % Standing Lines \f Debt Accounts |
Type Pay Type _[Type Description | Quaniyl | pay Type %
PRIME Superannuation 0.00 Allowance 0.00
FIM
Wi Pay Type Quantity Gross Days
PRIME Superannuation 0.00 0.00 0
: 0.000 Hide % \_w
Superannuation Member No  pR|1234567
Move Up Superannuation Employer % Apportionment 100.0
Move Down
0.00
Reference
Save & Exit Mext Delete Exit
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Contact Rates Financial Leave Standing Comment Documents STP Training

Tick this box if this employee has completed and signed their TFN declaration @

Date of declaration 1/06/2018

Cessation Type Code  Unspecified -

Notes:
= Refer to PayBiz documentation: Employees for full instructions on the above functions.

= The areas highlighted indicate the minimum detail preferred
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Tally Sheets

PayBiz main menu > Payroll > Tally Sheets > Add

Tally Sheets are the central entry point for all chargeable work to be entered.

From the Tally Sheet, payslips are created for staff and invoices are created for your customers.

TALLY SHEET

PAYSLIPS

TALLY SHEET LIMES

Each line includes:

Employee

Date

The Pay Type

Quantity (hours or tally)
Charge Out Rate

Hours

WAGE-COST REPORT

DEBTOR INVOICE

generated for staff as
tally sheet lines are
entered

Payslips are automatically

Easily and quickly view your
profit for this tally sheet
comparing the Wage costs
with the Charged prices

All tally sheet lines for the

same pay type and charge
rate are consolidated into

a single line on the invoice

Processing Flow Chart: http://www.shebiz.nz/pbhelp/docs/PB_TallySheetFlowchart.pdf

Tally Sheets: https://www.shebiz.nz/pbhelp/docs/PB_TallySheets.pdf
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Add Debtor
Tally Sheet : Enquire/Change
Job,Tally Sheet Mo 1024 Charged 1666.00
Client BB Boggy Burn Station Work Cover 268.14
Date In '14,1’09)‘2023 Date Out  14/09/2023 1 Wages 1849.26
Order No  Scott Rd Shed Default Hours 7.50 Running Costs 249.90
Payroll Date  14/09/2023 Days the Hours represent 1 Cost % 73.83
Lines \[ Invaicing Job / Comments eBiz
b 1

o Enter the Debtor Client code for the customer, Double click or F8 for lookup.
e Enter the tally sheet Date
e The Payroll Date - pay period for staff
This defaults to the Tally Sheet date, only change if necessary
e Enter the Default Daily Hours and Days if required (used to calculate average hourly rates)

Add Employee
o C(lick a blank line, or right click on an existing line, to open a new tally sheet line
o Enter the Employee Staff code, double click or F8 for lookup
e Enter the Date of work, pay type Code, Qty/Hrs and Hours worked
e Save & Next or Next to open a new tally sheet line
staff paBo Da Boss W Bt fmat Tally Sheet #'s
Date Code Description Qty/Hrs  Staff Base Rate Charge Rate  Hours  Days Inv Order
14/09/2023 FS Flock Shear 200.00 3.1500 31500 750 1 0
Inv Desc: Flock Shear 630.0000 630.0000
Description
CSN child Suppert 53 -63.00 0 0
aD OVERDRAWN PAY 65 -65.00 0 0
SUPER  |SUPERANNUATION 0 0.00 0 0
14/00/2023 BB FS Flack Shear 200 2.1500 630.00 75 1
Dlruliie ook tafie i ooen S8 5 soresy
Save / Refresh Save & Exit Mext Delete Exit
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% PAYBIZ

Invoice Tally Sheet

PayBiz main menu > Payroll > Tally Sheets

o Select the tally sheet, double click to open

Tally Sheet : Enquire/Change

Standing Charges

PT
sp
WC
PH
Admin

Charge Rates

Pay Type
FS - Flock Shear  ~

Invoice Comments

Save

Save .
- & Exit

Charge Rate

Payroll Tax
Supperannuation
Work Cover
Press Hire
Admin Fee

_. Disable Standing Charges

3.1500

Save
& Add

Details

Analysis

JobyTally Sheet No 024 Charged 666.00

Client BB Boggy Burn Station Wark Cover 268.14

Date In '14,’[}9}2[}23 Date Qut  14/08/2023 Wages 1849.26

Order Mo Scott Rd Shed Default Hours  7.30 ”"”:Ij’c‘n;t‘hw 248,80

Payroll Date  14/09/2023 Days the Hours represent 1 Update Mow 73.83
Lines Invaicing Job / Comments eBiz

ltem Code |Invoice Text m Payment Basis

5.00 Percentage (%)

0.00 Percentage (%)

14,50/ Percentage (%)
150.00 Fixed %

0.75 % per Head / Unit

Add Defaults

Invoice Description
Flock Shear

Cost Plus @D

Delete

Exit

Update

Update to Cost Plus

mvuice

Split Invoice by Date i
Close & Invoice

Inv Preview

@ preview
_iw Export

\_

Add Receipt

Historical Auto-York Cover

Work Cover % .00

Includes Super i

e Click the Close & Invoice button
e The invoice details are displayed as highlighted below
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Debtor Invoice : Enquire/Change

Debtor Invoice
Alpha BB 644604 Date 14/09/2023 |
Print
Name  Eoggy Burn Station Inv. No - 1024 Options
Tally Boggedown Pen. Int 3% | 15.0 Days| 7
Sheet  Out Back
Hometown VIC 1234 Mett 2659.86
Order Mo Scott Rd Shed Split By Grs '\ mpt Gst i Gst 256,74
Due 21/09/2023 Approved @D Gross 2016.60

Mon Stock Motes / Logo
E:nezu‘iptim‘u Gst Gross
Flock Shear 630.00 63.00 693.00
SHEARER 630.00 63.00) 693.00
Shedhand Run 406.00 40.60  446.60
Payraoll Tax (5%) 92.46 0.00 92.46
Supperannuation 183.26 1833 201.59
Work Cover 268.14 26.81 284,095
Press Hire 150.00 15.00 165.00
Admin Fee 300.00 30,000 330.00

Notes:

e Super, Payroll Tax and Work Cover will be automatically calculated based on your company settings

e Use the Print Options to print, email or export this invoice

Related documentation:

Processing Flow Chart: http://www.shebiz.nz/pbhelp/docs/PB_TallySheetFlowchart.pdf

Tally Sheets: https://www.shebiz.nz/pbhelp/docs/PB_TallySheets.pdf

Standing Charges: https://www.shebiz.nz/pbhelp/docs/PB_StandingCharges.pdf
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Advances

PayBiz main menu > Payroll > Advances

https://www.shebiz.nz/pbhelp/docs/PB_Advances.pdf

Use to enter payments made to employees before the end of the current pay period.

Once Pay is clicked:

e Advances are marked as Paid

e Advance lines are automatically added to the payslips

e Bank transactions are automatically created in the cashbook
e You can print the list of payments for your records

e You can generate a bank export file for import into your bank software

Advances : ADD

Emplovee Code

ANGHM
JE

Bank &/c Mame

'Paybiz DEMO Total
Date | 30/09/2021
Pay Type 'DF{

m Employee Full Mame2

150.00 Maxwell Smart
150,00 Agent 99

175.00 Angus Maneywell
100,00 Kirby Johi

Exit o

& Add Details Analysis Delete

Print List

Preview @
Export i

View Bank
Transactions

Export

e Click on a line to view/enter/edit the details

Staff
‘86

Amount

Bank Account (leave blank for Cash)

Tally Sheet 1014

Save & Exit

Total

Zero Cashbook Value '

Save & Mext Delete Exit
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Payslips

PayBiz main menu > Payroll > Payslips

Processing Flow Chart: http://www.shebiz.nz/pbhelp/docs/PB_PayslipsFlowchart. pdf

Payslips: https://www.shebiz.nz/pbhelp/docs/PB_Payslips.pdf

The Payslip screen is where you can manually Add new payslips, Edit existing payslips for non-tally sheet entries

such as Deductions or Comments, or View and Reprint paid payslips.

Pay Slip : Enquire/Change

Employee g5 Date 19/06/2022 Taxable Gross 297,19 Account 1 922.69
M Smart Payg 324,50 Account 2 0.00
Last Payslip Mett 24,75 Other 0.00 Account 3 0.00
STSL 0.00 Account 4 0.00
Mo Pays 1.0 Account 5 0.00
Re-Calc Mett 922,69 .
Payslip Manual Tax & W Paid Cash Amount 0.00
0.00
Pay Lines Comment/Leave Adjustment ETP Payment
50.00 -50.00 0.00
PRIME 0.00 0.00 0.00
13/06/2022 TIP TOP TOWMNIE F5 243.00 1224.72 0.00
13/06/2022 TIP TOP TOWNIE RAM 12.00 7247 0.00
Save Save . . . Print
Save = Details Analysis Delete Exit =
- & Exit & Add ¥ = = Options

e Additional columns can be added to the line table by right clicking on the grey column header and
choosing Insert Column. This means you can customise the details to your preferences.
e To add new lines right click on an existing line or left click on a blank line.

o Left click on an existing line to view or edit the details.

Quantity
44,00

Pay Type

hEAR GEAR PURCHASE

Reference

2 x Singlets

i Does not accrue holiday pay / Mot in average pay

Save & Exit Mext

Delete

Exit

e Comments can be added by clicking on the Comment/Leave Adjustment tab.

Page 20 of 26


http://www.shebiz.nz/
http://www.shebiz.nz/pbhelp/docs/PB_PayslipsFlowchart.pdf
https://www.shebiz.nz/pbhelp/docs/PB_Payslips.pdf

% PAYBIZ

P.O. Box 78
CROMWELL
9342, NZ

Ph 64 3 445 1345
www.shebiz.nz

Salary Staff - Generate Payslips
PayBiz main menu > Payroll > Generate Payslip
Generate Payslips

https://www.shebiz.nz/pbhelp/docs/PB_GeneratePayslips. pdf

e Auto generate wages or salary payslips

Staff on Salary most likely do not have their payslip created via a tally sheet.
function allows you to automatically generate the payslips for these staff.

Create Payslips

For Date :  3p/00/2021

Generate Exit

e Enter the For Date within the pay period
e Click Generate - payslips will be generated
e Payment will show in Banking Transactions when Pay Wages is clicked

Setting up Staff for Salary
PayBiz main menu > Payroll > Employees

https://www.shebiz.nz/pbhelp/docs/PB_Salary.pdf

e Rates tab:
o Remove the tick from No Auto Payslip.
o Enter the annual salary amount into the Salary field.

Therefore this

o Remove the tick from Add T/S lines to Payslip unless you want staff to be paid Salary AND tally

sheet work.
e Standing tab:
o Add a standing line for a Salary Pay Type

| Contact | Rates | Fimancial |/ Lleawe |/ Standing |/ Comment |/ Documents
Ratel 0.00 Salary 50000.00
Rate
Calculator Rate2 0.00 Aust.FBT 0
Rate3 0.00 Acc. Date
Averages
Rated 0.00 Mo Auto Payslip e
Hours/Week 40.00 Full Time Student Exe
. . Add T/5 lines to Payslip '_a
Basis F = Full time v / ysip
Contractor '
Branch
Base Rate Variance 0.0000 Use § value instead of %
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Contact |/ Rates |/ Financial |/ Leave |/ Standing Comment |/ Documen
(friEs % Standing Lines L
Type Pay Type |Type Description Eluantitj,f Pay Type
PRIME Superannuation 0.00 Allowance
SAL SALARY 1.00
Pay Type Quantity Gross Days
SAL SALARY 1.00 8961.54 5
Move Up
Maove Down
Reference
E— Save & Exit Mext Delete Exit
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Paying Wages
PayBiz main menu > Payroll > Pay/Check Wages

https://www.shebiz.nz/pbhelp/docs/PB_PayWages.pdf

Pay/Check Wages

Use To:
e Preview/check the unpaid payslips
e  Print the payslips
e Print the payrun reports - Payment Rpt and Detail Rpt

Pay Wages

Detail Options

PaySlip Date From :  12/02,/2021 Coples] 1 Payslips Combine Pavslins
To: 12/02/2021 Payment Rpt
Sort By Date and Employee Code v New Page/Emp
Preview @D

Payment Date :  14/02/2021

Export i @ Inc. Emp.Detail

Bank Account  03-0214-0562475-00 i
_kw Show Reference

A0 Bank AUS Pay Wages T T
Attach this file to emailed payslips
D/ Crds
Employee Filtter
Cash
STP
Payslip Print Detail Rpt.
Comment Exit
@ summary Rpt
e Pay Wages

Pay Wages

Detail Options

Payslip Date From: 12022021 o€ 1 Payslips e P
To: 12/02/2021 Payment Rpt
Sort By Date and Employee Code v A PR R
Preview @0

Payment Date : 14/02/2021

Export i @ Inc. Emp.Detail
Bank Account  (3-0214-0562478-00 °

| .. Show Reference
A0 Bank AUS Pay Wages nc. Paid

Attach this file to emailed payslips
D/Crds

Employee Filter
Cash oy

e Enter the To and From payslip dates
e Select the functions required
e Bank Account must be entered to pay wages

Once wages are marked as paid in the system, you can pay the wages through your normal practice.
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Export to the Bank

Note:

Click D/Crds (from window above)

Banking Transactions will open

Select Export to create the bank file to upload
Send file to bank using the bank software

Cashbook Payroll : Enquire/Change

Mame Of Other Party

Bank A/c Name DEMOC Bank AUS

Date 14/02/2021

Mts

Particulars

Wages D/Crd

Code|Reference Purpose

PAY WAGES 123456 BLOJ -146.20
PAY WAGES |01-2356-0024569-00 TUB -604.60
PAY WAGES  |12345-123456 JC2 -1214.14
PAY WAGES  |03-1268-0014587-00 MA... -157.00
PAY WAGES 1236985214 NC -676.24
PAY WAGES 123456 1234567830 DD -199.45
PAY WAGES | 06-4568-0021456-00 MUS -153.60
PAY WAGES |26-0321-2584568-00 GOT -383.52
PAY WAGES 1245789636 HS -144,00
M MANN C... 012345 12345678 MUS -38.40
PAY WAGES  |012345-12345678 GOT -200.00
G SHORN C... 012345 12345678 GOT -110.00
Report Export ® e ST

Analysls Qelete

Bank Statement

Date

Page Mo

Code

Exit

Bank Reference

PAY WAGES

e File export can be done at any time via: PayBiz main menu > Banking > Banking Transactions
Select the transaction and click display.
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STP - Reporting to the ATO

Pay Wages

Detail Options

payslip Date From : 12/02/2021 ~ _°P'¢® 1 Payslips el FavEhse
To: 1z2/02/2021 Payment Rpt
Sort By Date and Employee Code v E
Preview @0

Payment Date :  14/02/2021
Export L @ inc. Emp.Detail
Bank Account  (3-0214-0562478-00 P
_kw Show Reference

JEMO Bank AUS Pay Wages . Paid
Attach this file to emailed payslips
D/Crds
Employee Filter
Cash
5TP
Payslip Print Detail Rpt.
Comment Exit

@ summary Rpt

e Click STP to open the Auto Pay Event screen:

Ato Pay Event : Enquire/Change

Pay Date 14,/02/2021 55P Status

Submission Id 2007044 ATO Status
ATO Substatus

Total Gross 3640

Total PAYG 666.50

Contact Name  Lisa Wardill Filed Previous

Contact Phone (06434451345
o i Validate XML File
Contact Email  lisa@shebiz.nz

Declaration

I declare the information transmitted in this i Accept Declaration
payroll report is true and correct and | am
authorised to make this declaration. Declared By Dave

Declaration Date  =0/00,/202¢

Tick this box to sign this declaration with the
credentials you used to login and the AUSkey

used by your software. Submit XML File

Status: UNSENT

Details Analysis Delete Exit

e Complete the STP filing details, click Validate XML File then tick Accept Declaration and Submit XML
File

e The file will be sent via OZEDI: https://dashboard-stp.ozedi.com.au/register?link=115115105-R

e C(Click Get ATO Response before submitting the next pay event.
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Payslips and Paying Wages Flow Chart

Deductions to
add?

All Tally Sheets
Entered?

Pay/Check Wages
[PayToll menu)

Enter bank acct to pay
from. Click Pay Wages

Export Bank
File?

Tax File Reporting
IRD [NZ) or 5TP (Aus)

Finish

Generate Payslips
[Payroll memu)

Open Advances to add lines
Eg: Gear, Approved Draws
(Payroll menu)

Enter remaining Tally
Sheets
[Make Payslips if pay per shed)

Payslips
Check & Print

Payment Rpt
For Direct Credit list

Payslip Summary Report
(Detail Report)

Click D/Crds then Export
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